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ABSTRACT 

  

Abstract: This study aims to design an information system that can support research 

implementation of target costing system with Data Analysis Program, to design the Program Data 

analysis in research, analyse the effectiveness of the program to be used and evaluate the weakness 

and superiority of the program will come. In this study the authors use the questionnaire 

distribution tool Design Model Relational Data Target Costing System, for the purpose of research 

can be achieved more accurately. In designing the design of Target Costing questionnaire to the 

built system shows that the Target Costing questionnaire that has been designed is useful to 

provide an information system that can generate output (output) and input (entry, edit, inquiry, add 

record), based on the input query According to the required researcher needs related to the target 

costing. Access program as a tool to design, create tables, create forms and create reports. To 

display accurate results, then by designing the Target Costing questionnaire, can display data that 

produces graphs, reports, queries or filter data with Filter by Form to facilitate the search data in 

accordance with the needs of researchers. 
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PENDAHULUAN 

Menganalisis implementasi target 

costing system di Indonesia. Riset tentang 

implementasi target costing system adalah 

sangat penting untuk dilakukan di 

Indonesia, karena target costing dapat 

digunakan untuk menentukan desain produk 

yang profitable di awal siklus hidup produk. 

Target Costing System merupakan suatu 

pendekatan baru yang dapat membantu 

untuk menciptakan produk-produk yang 

berkualitas (Institute of Management 

Accountants, 1998). 

Dalam penelitian ini perlu didukung 

dengan data-data yang akurat. Data-data 

kuesioner yang dikumpulkan tidak harus 

berupa angka-angka saja, namun bisa juga 

dalam tekstual atau dalam bentuk parameter 

lainnya. Data-data ini ada yang bersifat 

nominal, ordinal, interval, dan rasio, 

terutama data-data yang bersifat kualitatif 

seperti ucapan-ucapan, tanggapan-

tanggapan, tulisan-tulisan dan lain 

sebagainya yang dikumpulkan dan di 

analisa untuk meningkatkan suatu 

pemahaman tentang kejadian atau fenomena 

yang menjadi minat penelitian atau biasa 

disebut juga sebagai point of interest. Pada 

akhirnya data inilah yang akan diolah dan di 

desain sebagai kuesioner sesuai dengan 

tahapan penelitian yang ada.  

Dalam melakukan penelitian salah 

satu hal yang penting ialah membuat desain 

eksperimental yang merupakan suatu 

metodolgi yang tepat untuk membantu 

penelitian yang dilakukan dalam bidang 

ilmu komputer. Selain itu ada pendekatan 

ilmiah untuk memunculkan pengetahuan 

baru.  

Desain kuesioner dalam penelitian ini 

untuk mempermudah dalam pengisian 

kuesioner dalam berbagai jenis perusahaan 

industry antara lain industri mobil, 

elektronik, peralatan rumah tangga maupun 

barang konsumen yang ada di perusahaan-

perusahaan di Indonesia, sehingga dari segi 

output bisa menghasilkan hasil print out,
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rekapitulasi kuesioner maupun grafik 

kuesioner yang telah dilakukan dari hasil 

penyebaran kuesioner target costing system 

kepada perusahaan-perusahaan di 

Indonesia. Tanpa menggunakan program 

desain kuesioner seorang peneliti tidak akan 

dapat melihat berapa jumlah kuesioner yang 

telah yang telah dikirimkan dan kembali 

kemudian rekapitulasi hasil kuesioner dari 

berbagai  jenis industri yang telah dilakukan 

oleh para peneliti. Manfaat desain kuesioner 

penelitian akan dirasakan oleh semua pihak 

yang terlibat dalam proses penelitian, 

karena dapat digunakan sebagai pedoman 

dalam melakukan proses penelitian.  

Selain itu, agar sebuah penelitian 

memiliki batasan-batasan dan dapat disusun 

secara terstruktur dan terkonsep dengan 

baik, maka diperlukan sebuah metode 

penelitian mengingat betapa pentingnya 

desain dan metode penelitian. Salah satu 

alat desain kuesioner sistem informasi 

pemetaan riset akuntansi dengan 

pendekatan target costing system adalah 

sistem berbasis komputer dengan 

menggunakan Microsoft Acces untuk 

membantu mempermudah dalam 

pengolahan data kuesioner yang selama ini 

belum  ada.   

Tujuan penelitian ini adalah : untuk 

mendesain sistem informasi yang dapat 

mendukung riset-riset implementasi target 

costing sisem dengan Program Analisis 

Data, untuk merancang Program Analisis 

data dalam penelitian, menganalisis 

efektifitas program yang akan digunakan, 

dan mengevaluasi kelemahan dan 

keunggulan program akan datang.  

 

TINJAUAN PUSTAKA 

Konsep Dasar Informasi 

 “Informasi adalah data yang telah 

diolah menjadi bentuk yang memiliki arti 

bagi si penerima dan bermanfaat bagi 

pengambilan keputusan saat ini atau 

mendatang ” (Cleod, 2002). Secara umum 

informasi dapat didefinisikan sebagai hasil 

dari pengolahan data dalam suatu bentuk 

yang lebih berguna dan lebih berarti bagi 

penerimanya yang menggambarkan suatu 

kejadian-kejadian yang nyata digunakan 

untuk pengambilan keputusan. 

Sumber dari informasi adalah data. 

Data adalah kenyataan yang 

menggambarkan suatu kejadian-kejadian 

dan kesatuan nyata. Kejadian-kejadian 

adalah sesuatu yang terjadi pada saat 

tertentu. Di dalam dunia bisnis, kejadian-

kejadian yang sering terjadi adalah transaksi 

perubahan dari suatu nilai yang disebut 

transaksi. Kesatuan nyata adalah berupa 

suatu obyek nyata seperti tempat. Benda, 

dan orang yang betul-betul ada dan terjadi. 

Data yang diolah melalui suatu 

model menjadi informasi, penerima 

kemudian menerima informasi tersebut, 

membuat suatu keputusan dan melakukan 

tindakan, yang berarti menghasilkan suatu 

tindakan yang lain yang akan membuat 

sejumlah data kembali. Data tersebut akan 

ditangkap sabagai input, diproses kembali 

lewat suatu model dan seterusnya 

membentuk suatu siklus.   

 

Kualitas Informasi 

Menurut Jogiyanto (2005:10) 

Kualitas dari suatu informasi (Quality of 

Information) tergantung dari tiga hal, yaitu 

informasi harus akurat (Accurate), tepat 

pada waktunya (Timeliness), dan relevan 

(Relevance). Menurut Tata Sutabri 

(2005:35) Kualitas suatu informasi 

tergantung dari tiga hal yaitu, informasi 

harus akurat (Accurate), tepat waktu 

(Timeliness), dan relevan (Relevance).  

 

Sistem Informasi 

Untuk memahami pengertian sistem 

informasi, harus dilihat keterkaitan antara 

data dan informasi sebagai entitas penting 

pembentuk sistem informasi. Data 

merupakan nilai, keadaan, atau sifat yang 

berdiri sendiri lepas dari konteks apapun. 

Sementara informasi adalah data yang telah 

diolah menjadi sebuah bentuk yang berarti 

bagi penerimanya dan bermanfaat dalam 

pengambilan keputusan saat ini atau 

mendatang (Davis, 1995). Mc Leod (1995) 

mengatakan bahwa informasi adalah data 
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yang telah diproses, atau data yang 

memiliki arti. 

Sistem Informasi Manajemen (SIM) 

dapat didefinisikan sebagai suatu alat untuk 

menyajikan informasi dengan cara 

sedemikian rupa sehingga bermanfaat bagi 

penerimanya (Kertahadi, 1995). Tujuannya 

adalah untuk menyajikan informasi guna 

pengambilan keputusan pada perencanaan, 

pemrakarsaan, pengorganisasian, 

pengendalian kegiatan operasi subsistem 

suatu perusahaan, dan menyajikan sinergi 

organisasi pada proses (Murdick dan Ross, 

1993).  

 

Komponen Sistem Informasi 

Sistem informasi terdiri dari 

sekelompok komponen yang saling 

berhubungan, bekerja sama untuk mencapai 

tujuan bersama dengan menerima input 

serta menghasilkan output dalam proses 

transformasi yang teratur (Ladjamudin, 

2005).  

Kerangka konsep berbagai komponen 

dan aktivitas sistem informasi dapat dilihat 

pada gambar di bawah ini : 

 
Gambar 1 Kerangka Konsep 

Berdasarkan gambar di atas, komponen-

komponen sistem informasi terdiri dari: 

  

1. Manusia 

Manusia diperlukan dalam operasi 

sistem informasi. Sumber daya manusia 

ini meliputi pemakai akhir dan pakar 

sistem. Pemakai akhir adalah orang 

yang menggunakan informasi yang 

dihasilkan sistem informasi, misalnya 

pelanggan, pemasok, teknisi, 

mahasiswa, dosen dan orang-orang yang 

berkepentingan. Sedangkan pakar 

sistem informasi adalah orang yang 

mengembangkan dan mengoperasikan  

sistem informasi, misalnya system 

analyst, developer, operator sistem dan 

staf administrasi lainnya (Mulyanto, 

2009). 

2. Hardware  

Sumber daya hardware adalah semua 

peralatan yang digunakan dalam 

memproses informasi, misalnya 

komputer dan periferalnya, lembar 

kertas, disk magnetic atau optik dan 

flash disk (Mulyanto, 2009). 

3. Software 

Software merupakan sekumpulan 

perintah/fungsi yang ditulis dengan 

aturan  tertentu untuk memerintahkan 

komputer agar melaksanakan sesuatu 

(Ladjamudin, 2005). 

4. Data 

Data merupakan dasar sumber daya 

organisasi yang diperlukan untuk 

memproses informasi. Data dapat 

berbentuk teks, gambar, audio maupun 

video. Sumber daya informasi umumnya 

diatur, disimpan dan diakses oleh 

berbagai pengelolaan sumber daya data 

ke dalam database dan dasar 

pengetahuan (Lajamudin, 2005). 

5. Jaringan 

Sumber daya jaringan merupakan media 

komunikasi yang menghubungkan 

komputer, pemroses komunikasi dan 

peralatan lainnya dengan kendali 

software komunikasi. Jaringan dapat 

berupa kabel, satelit, seluler dan 

pendukung jaringan seperti modem, 

software pengendali serta prosesor antar 

jaringan (Ladjamudin, 2005). 

Keseluruhan komponen sistem informasi 

tersebut saling terkait satu sama lain dalam 

sistem informasi. Sistem informasi 

dibangun menggunakan teknologi 

komunikasi dan informasi yaitu hardware, 

software dan jaringan.  Ketiga komponen 

tersebut dipakai untuk mengolah data yang 

diperoleh untuk menghasilkan informasi 

yang lebih bermanfaat. Keseluruhan proses 
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pengolahan informasi tidak lepas dari 

komponen manusia. Manusia adalah 

komponen penting sistem informasi karena 

sistem informasi adalah benda yang tidak 

bermanfaat bila tidak digunakan oleh 

manusia.  

Aktivitas Sistem Informasi 

Stair (1992) menjelaskan bahwa 

sistem informasi berbasis komputer (CBIS) 

dalam suatu organisasi terdiri dari 

komponen-komponen berikut :  

a. Perangkat keras, yaitu perangkat keras 

komponen untuk melengkapi kegiatan 

memasukkan data, memproses data, dan 

keluaran data. 

b. Perangkat lunak, yaitu program dan 

instruksi yang diberikan ke komputer. 

c. Database, yaitu kumpulan data dan 

informasi yang diorganisasikan 

sedemikian rupa sehingga mudah 

diakses pengguna sistem informasi. 

d. Telekomunikasi, yaitu komunikasi yang 

menghubungkan antara pengguna sistem 

dengan sistem komputer secara 

bersama-sama ke dalam suatu jaringan 

kerja yang efektif. 

e. Manusia, yaitu personel dari sistem 

informasi, meliputi manajer, analis, 

programmer, dan operator, serta yang 

bertanggung jawab terhadap perawatan 

sistem. 

f. Prosedur, yakni tata cara yang meliputi 

strategi, kebijakan, metode, dan 

peraturan-peraturan dalam 

menggunakan sistem informasi berbasis 

komputer. 

Sementara Burch dan Grudnitski 

(1986) berpendapat, sistem informasi yang 

terdiri dari komponen-komponen di atas 

disebut dengan istilah blok bangunan 

(building block), yaitu blok masukan (input 

block), blok model (model block), blok 

keluaran (output block), blok teknologi 

(technology block), dan blok kendali 

(control block). Sebagai suatu sistem,  

keenam blok tersebut masing-masing saling 

berinteraksi satu dengan yang lainnya 

membentuk satu kesatuan untuk mencapai 

sasarannya. 

Sementara, menurut pendapat Davis (1995), 

sistem informasi manajemen terdiri dari 

elemen-elemen berikut : 

1. Perangkat keras komputer (hardware) 

2. Perangkat lunak (software), yang terdiri 

dari perangkat lunak sistem umum, 

perangkat lunak terapan, dan program 

aplikasi. 

3. Database 

4. Prosedur 

5. Petugas operasional. 

 

Sistem Pendukung Keputusan 

Pengambilan keputusan merupakan 

proses pemilihan alternatif tindakan untuk 

mencapai tujuan atau sasaran tertentu. 

Pengambilan keputusan dilakukan dengan 

pendekatan sistematis terhadap 

permasalahan melalui proses pengumpulan 

data menjadi informasi serta ditambah 

dengan faktor – faktor yang perlu 

dipertimbangkan dalam pengambilan 

keputusan. 

Menurut Simon (Kadarsah, 2002:15-

16), tahap – tahap yang harus dilalui dalam 

proses pengambilan keputusan sebagai 

berikut :  

1.   Tahap Pemahaman (Inteligence Phase) 

Tahap ini merupakan proses 

penelusuran dan pendeteksian dari 

lingkup problematika serta proses 

pengenalan masalah. Data masukan 

diperoleh, diproses,  dan diuji dalam 

rangka mengidentifikasikan masalah. 

2.   Tahap Perancangan (Design Phase) 

Tahap ini merupakan proses 

pengembangan dan pencarian alternatif 

tindakan / solusi yang dapat diambil. 

Tersebut merupakan representasi 

kejadian nyata yang disederhanakan, 

sehingga diperlukan proses validasi dan 

vertifikasi untuk mengetahui 

keakuratan model dalam meneliti 

masalah yang ada. 

3.   Tahap Pemilihan (Choice Phase) 

Tahap ini dilakukan pemilihan terhadap 

di antara berbagai alternatif solusi yang 

dimunculkan pada tahap perencanaan 

agar ditentukan / dengan 
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memperhatikan kriteria – kriteria 

berdasarkan tujuan yang akan dicapai. 

4.   Tahap Impelementasi (Implementation 

Phase) 

Tahap ini dilakukan penerapan 

terhadap rancangan sistem yang telah 

dibuat pada tahap perancangan serta 

pelaksanaan alternatif tindakan yang 

telah dipilih pada tahap pemilihan. 

 

METODE PENELITIAN 

Sifat Penelitian 

Dalam penelitian ini penulis 

menggunakan alat penyebaran kuesioner 

Desain Model Relasional Data Target 

Costing System, agar tujuan penelitian dapat 

dicapai lebih akurat. Desain kuesioner yang 

lebih rinci mengenai suatu isian data selama 

kurun waktu tertentu dengan cukup 

mendalam dan menyeluruh yang meliputi 

berbagai jenis perusahaan di bidang 

otomotif (mobil), makanan dan minuman, 

elektronik, peralatan rumah tangga maupun 

barang konsumen yang ada di Indonesia. 

 

Desain Kuesioner Sistem Informasi 

Pemetaan Riset Akuntansi 

Database atau biasa juga disebut Basis 

Data adalah kumpulan data yang 

berhubungan dengan suatu obyek,  yste 

atau tujuan khusus tertentu. Sebagai contoh 

buku telepon, kamus bahasa, katalog buku 

di perpustakaan, data koleksi  yste dan 

video, data pelanggan, data pemasok, data 

mahasiswa, data pegawai, dan lain-lain. 

 

Pembuatan Desain Kuesioner, dengan 

Microsoft access 2010 

Pembuatan Tabel 

 
Gambar 2. Pembuatan Tabel Kuesioner 

 

1. Membuat Menu Utama / Swithboard 

Langkah-langkah pembuatan Menu 

Utama 

Tools -> Database Utilities -> Switcboard 

Manager -> Yes -> Edit -> Ketik Target 

Costing -> New -> ketik nama menu  I. 

Data Perusahaan -> Command -> pilih 

Open from edit mode -> Form -> sesuai 

dengan urutan menu utama (Switchboard) -

> kembali ke New untuk penulisan 

selanjutnya, kemudian klik close (selesai). 

 

Langkah membuat Switchboard  

 
Gambar 3. Desain Switchboard I 

 

 
Gambar 4. Desain Switchboard II 

 
Gambar 5. Desain Switchboard III 
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Gambar 6. Desain Switchboard IV 

 

2. Menu I. Data Perusahaan s/d VI. 

Kemampuan-Kemampuan Dinamik 

Langkah-langkah pembuatan tampilan  

Quisioner1 s/d QuisionerVI: 

 Create -> Form Wizart -> kemudian 
table quisioner dipindah ke selected 

field sesuai dengan urutan di buku 

quisioner yang terdiri dari No, Nama 

Perusahaan, Jenis Indutri dst, -> Next -> 

Columnar -> Modify the form’s design -

> Finish 

Langkah membuat combo box pada sub 

quisionerI s/d VI. 

 View -> Design -> Label -> di tarik ke 

form quisioner1 di Detail -> kemudian 

digeser ke kanan untuk menulis kalimat 

per item di dalam form quisioner1. 

 Kemudian untuk seting pilihan Ya / 
Tidak sesuai dengan nomor urutan 

quisioner, klik II1 -> Properties -> 

Property Sheet -> Data -> Pilih Row 

Source Type -> Values List -> Row 

Source -> Klik  keluar tampilan Edit 

List Items -> di isikan sesuai dengan 

macam-macam pilihan di dalam combo 

box. 

  

3. Desain Menu Grafik dan Rekap 

Langkah – Langkah pembuatan tampilan 

menu grafik dan rekap 

Desain Grafik 

 Design   -> di tarik -> klik 
from operation (grafik) -> open from 

-> next -> pilih II2 (struktur field 

database quisioner) -> klik next 3x -

> kemudian finish. 

Desain rekap 

 Design ->  -> di tarik -> klik 

miscellius (rekap) -> run query -> 

next -> next -> rekap2 (struktur field 

database quisioner) -> klik next 3x -

> kemudian finish. 

 

4. Desain Hasil Report Grafik & 

Rekapitulasi 

Langkah – langkah pembuatan Report 

Grafik dan Rekapitulasi 

 Report Grafik 

Create -> Report Design -> Design -> 

Chart sorot ke Page Header (Report1) -> 

Klik Queries -> Next -> Back -> Query: 

Rekap II1, kemudian ada pilihan  

Available Field -> II1 & countOf II1 -> 

Move ke Fields of Chart -> next -> Pilih 

Grafik 3-D Pie Chart -> Next -> Finish, 

save dengan nama file Rekap1 

 Report Rekapitulasi 

Klik Rekap1 -> klik kanan -> Design 

view -> Design -> Klik Subform 

/Subreport -> klik, kemudian pindahkan 

ke Page Header (Rekap1) -> Klik 

Subreport Wizart -> Next – 

Tables/Queries -> Pilih Query:Rekap 

II1 -> pilih struktur database quisioner 

& CountOfII6  -> Move ke selected 

fields  -> Next -> Finish 

 

5. Penyempurnaan Angka Numeric di 

field Access 

 Sumber data Excel isian Total 
Pekerja Tahun 2011 dan 2012 data 

tersebut diterjemahkan database 

access : < 100, 100 – 500, 500 – 

1000, > 1000. 

 Sumber data Excel isian lama 
penggunaan Target Costing dalam 

sekian tahun, data tersebut 

diterjemahkan ke database access : < 

5, 5 – 10, 10 – 15, > 15 

 Sumber data Excel isian jumlah 

pekerja Target Costing yang 

mempunyai wewenang data tersebut 

diterjemahkan ke database access : < 

10, 10 – 50, 50 – 100, > 100 
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PEMBAHASAN 

Pengembangan Desain Program 

Quisioner Target Costing 

Langkah pertama adalah membuka 

program microsoft access seluruh file yang 

dibutuhkan. Langkah – langkah yang dapat 

diambil adalah sebagai berikut :  

Shortcut | Target Costing 

1. Menu Utama 

Menu Utama terdiri dari Data 

Perusahaan, Latar Belakang Informasi 

TC, Penyimpangan Perilaku, Hasil 

Kinerja, Faktor-Faktor keberhasilan, 

Kemampuan-Kemampuan Dinamik, 

Grafik & Rekap. 

 
Gambar 7. Menu Utama 

 

Pada gambar 4.1 menggambarkan suatu 

tampilan judul dan menu-menu lainnya 

yang tertera dalam suatu tampilan gambar 

di atas. 

2. Menu Tabel Database Quisioner mengacu 

pada buku panduan kuesioner Target 

Costing.

 
Gambar 8. Data Responden Kuesioner 

 

3. Menu Data Perusahaan 

 
Gambar 9. Isian Data Perusahaan 

 

4. Isian Jenis Industri yang terdiri dari 

Otomotif, Elektronik, Peralatan Rumah 

Tangga, Barang Konsumen dan Lain-

lain 

 
Gambar 10. Isian Jenis Industri 

  

5. Isian Total jumlah pekerja tahun 2011 

& 2012 

 
Gambar 11. Isian total pekerja 2011 & 2012 

6. Menu Latar Belakang Informasi 

Implementasi Target Costing 
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Gambar 12. Isian Latar Belakang TC 

 

7. Menu Penyimpangan Perilaku 

 
Gambar 13. Isian Penyimpangan Perilaku  

 

Hasil Kinerja 

 
Gambar 14. Hasil Kinerja 

 

 

 

 

 

 

 

 

 

 

 

 

8. Faktor – Faktor Keberhasilan 

 
Gambar 15. Faktor-Faktor Keberhasilan 

 

9. Kemampuan – Kemampuan yang 

Dinamik 

 
Gambar 16. Kemampuan-Kemampuan 

Dinamik 

10. Grafik & Rekap 

 
Gambar 17. Hasil Output Grafik dan Rekap 

 

KESIMPULAN DAN SARAN 

Kesimpulan 

Dalam perancangan desain kuesioner 

Target Costing terhadap sistem yang 

dibangun maka dapat diambil suatu 

kesimpulan sebagai berikut : 
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1. Kuesioner Target Costing yang telah di 

desain bermanfaat untuk memberikan 

suatu sistem informasi yang bisa 

menghasilkan keluaran (output) maupun 

input (entri, edit, inquiry, add record), 

berdasarkan query yang di input sesuai 

dengan kebutuhan peneliti yang 

diperlukan terkait dengan target costing. 

2. Program Access sebagai alat untuk 

mendesain, membuat table, membuat 

form dan membuat laporan 

3. Untuk menampilkan hasil yang akurat, 

maka dengan merancang kuesioner 

Target Costing, dapat menampilkan data 

data yang menghasilkan grafik, report, 

query maupun menyaring data dengan 

Filter By Form untuk mempermudah 

dalam pencarian data sesuai dengan 

kebutuhan peneliti. 

 

SARAN 

Dengan selesainya pembuatan 

program Desain Target Costing, dari 

beberapa kesimpulan yang diambil diatas, 

dapat dikemukakan saran-saran program 

yang telah kami desain masih banyak 

kekurangan-kekurangan sehingga dalam 

pengembangan pembuatan software tersebut 

masih perlu ditingkatkan lagi perbaikan-

perbaikan untuk melengkapi software. 
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